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. Disclaimer: MainStreetGIS has done its best
MalnstreetMapbOOkS to make sure that this software functions
reliably, however, we cannot guarantee error-
free code. By using this tool, you agree not
to hold MainStreetGIS liable for any errors
resulting from its use. Please employ

rigorous quality-control measures.
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I - Overview:

MainStreetMapbooks is a plug-in for ArcGIS™ that easily creates a custom mapbook from an ArcMap™
project. A mapbook is a book of map pages where each page corresponds to a specific area of a much larger
map. Typically, the large map area is broken down using a grid of rectangles, where each rectangle
corresponds to one page in a mapbook. The mapbook, with information covering large areas, can be easily
taken into the field or provide a convenient reference for use in the office.

The main purpose of MainStreetMapbooks is to automate the printing or exporting of each page in your
mapbook so you can create multiple copies with ease and regularly print new mapbooks as your data layers are
edited and updated. MainStreetMapbooks will walk you through the creation of a grid layer, if you do not have
one, but is also able to use the features from any layer in your map to define the location of each page in your
mapbook. This flexibility enables the use of GPS points, Pipe Lines, Streets, Buildings, Lakes, Watersheds, and
any other areas of interest, to quickly define a new mapbook.

Typically, each page in a mapbook will contain a primary frame (your main map image), along with other map
elements. Map numbers, legends, overview frames, and index frames add information about the current map
area and show the relationship of the current map area to the entire grid system. With just a few clicks,
MainStreetMapbooks will walk you through the creation of each of these and other useful map elements.
MainStreetMapbooks automatically updates each map element for every page in your mapbook.

Before continuing, let’s define a few terms:

Active Layer— This is the layer in your main data frame that contains the locations for each page in your
mapbook. Typically this would be your grid layer, where each tile or rectangle in the grid corresponds to one
polygon feature. If using a layer other than a grid layer, the only difference is that you are not working with
rectangles that might match your page layout. You will have to explicitly define the map scale (see Scale tab
section).

Search Field — A field within the Active Layer that contains unique values. In a grid system, this would be the
ID field for each grid tile.

Row / Column Fields — When using a grid layer, these fields contain the row and column values for each grid
tile. If your tile IDs are Al, A2, B1, B2, etc. the row values might be A, A, B, B and the columns 1, 2, 1, 2.

Primary Data Frame — The main data frame in your map that contains all the layers to be printed / exported.
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Il - Installation:
Requirements: Any Windows computer running ArcGIS™ version 9.0 and higher
To add MainStreetMapbooks to any compatible ArcMap™ project:

1 - Launch ArcMap™

2 — From the Tools menu, select “Customize”

3 — Click the Commands tab

4 - At the bottom of the Commands window, next to "Save in", you can choose to save the tool to either the
current project or to the Normal.mxt file. If you save it to the current project, it will be available the next time the
project is loaded. If you save it to the Normal file, it will be available to all projects. Please see ArcMap™
documentation for a description of the Normal file.

5 - Click "Add from file..." and navigate to the installation folder that contains the MainStreetMapbooks.dll file.
6 - Choose to load MainStreetMapbooks.dll

7 - The tool should now be loaded to the MainStreetGIS category, on the left, and “MainStreetMapbooks”
should be highlighted on the right, in the Commands box.

8 - Drag and drop the highlighted "MainStreetMapbooks™ text to any toolbar.

9 — Click the icon to launch MainStreetMapbooks.

10 — After launching the tool once, the Program Files directory structure will be created.

Copy the Bin folder from the installation directory to C:\Program Files\MainStreetGIS\MainStreetMapbooks\
(not available in evaluation version)

Uninstalling the Plug-in:

To remove MainStreetMapbooks from ArcMap, simply delete the MainStreetMapbooks.dIl file with all ArcGIS
software closed. Copying it first to another location will create an uninstalled copy that you can archive for use
at another time.

111 - The Navigation Area:

Search menu:

The Search menu is populated with values from the search field in the active layer, as defined in the Main tab. Ideally, the
search field will contain unique values so that each feature in the active layer is represented.

Selecting a value from the Search menu will zoom the map to the first feature found in the active layer with a matching
value in the search field.

When zooming, be sure to set your scale method in the Scale tab, and define the data frames
to be zoomed from the data frame list on the Main tab.

Hint: If you're using a grid layer with a coordinate, row/column, system, you may want to point the Search field to a field that is a
concatenation of the row and column fields. The concatenated values should provide a unique identifier for each cell in your grid system.
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Find menu:

In the Find text box, enter values to look for in the Search menu. The best match is displayed as you type. To zoom to an
item found in the Search menu, click the Go button.

Row / Column menus:

Grid layers are typically indexed with a coordinate system where each cell is given a row and a column value, such as Al,
A2, A3, B1, B2, etc.

If your active layer contains Row and Column fields, as are typically found in a grid layer, values from the Row and Column
fields will be loaded into these menus, as defined in the Main tab.

After choosing a Row and a Column value, hit the Go button to zoom the map.

When zooming, be sure to set your scale method in the Scale tab, and define the data frames
to be zoomed from the data frame list on the Main tab.

IV - The Tab Pages:

Main tab:

The Layer menu is loaded with layers from your primary or active data frame. To define a new active layer, choose a layer
name from the list. When a layer name is selected, the field menus below will populate with field names from the selected
layer. Choose a Search field from the selected layer and optionally Row and Column fields. The Apply button will set the
selected layer as the current active layer and will populate the search menus in the Navigation area.

The data frame list displays the current data frame names in your map. Data frames in the list that are highlighted will be
zoomed along with the primary data frame when an item is selected in the Navigation area or when Printing or Exporting.

Each data frame to be zoomed must contain a copy of the active layer. The layer properties
may be modified as needed, but the layer name must match that of the active layer.

Grids tab:
Use the grid creation wizard to automatically create a new grid based on the extent of your current map.

Use the grid layer list to load previously created grids to you map.

Print tab:
There are 4 options available for printing mapbooks:

A - Print a map for each feature in the Search list or Row/Column list
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B - Print a map for each feature in the current ArcMap selection
C - Print a map for each feature with values matching those selected in the Selection list on the Selection tab
D - Print the current map layout

The Advanced button offers controls to emulate duplex (double-sided) printing and to induce a time delay between map
zooms.

Export tab:

There are 4 options available for exporting mapbook pages as image files:

A - Export a map for each feature in the Search list or Row/Column list

B - Export a map for each feature in the current ArcMap selection

C - Export a map for each feature with values matching those selected in the Selection list on the Selection tab
D - Export the current map layout

The Output File section provides controls for defining the exported images:

- Set the image format/file type

- Set the image resolution in dots-per-inch (DPI)

- Set the general file name. If exporting multiple images, choose to append the corresponding search value from the Search
list, or simply a numeric increment. If the zero-fill option is checked, the appended value will be padded with zeros up to
the width of number of images being exported. For example, map number 9 of 100 images become 009. This can help
with file sorting.

- Set the output directory to hold the exported images.

The Advanced button offers controls to emulate duplex (double-sided) printing and to induce a time delay between map
zooms.

Important! Images in the output directory will be overwritten without warning if the file names
are the same.

Hint: When exporting multiple pdf images, MainStreetMapbooks automatically creates a file called combined.pdf containing each of the
individual pdf documents combined into one multi-page pdf document. Be sure to install the Bin folder as described in the Installation
instructions. (not available in evaluation version)

Layout tab:

The Layout tab provides controls for automatically adding useful data frames and map elements to your map layout.

Data Frames...

Map Number - Adds a data frame that updates with each zoom to display the current map number or other identifier. It
copies your active layer to the new frame and adjusts the layer properties to display a field value. The default value is the
current Search field.

Be sure to select this data frame to be updated in the "Data frames to zoom" list on the Main tab.

Hint: Use this same feature to place labels from other fields in your active layer by adjusting the layer's Label Properties.
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Index Map - When using a grid layer as your active layer, the index map shows your current grid tile in red as well as each
adjacent grid tile so you can see which page to go to in the mapbook when moving north, south, east, west, etc.

Be sure to select this data frame to be updated in the "Data frames to zoom" list on the Main tab.

Hint: Change the color of the red location frame in the data frame properties or change its symbol to be solid.
Hint: Change the extent of the data frame by zooming in or out. If the zoom tools are inactive, set the extent to "Automatic” in the data

frame properties and then set it back to "Fixed Extent".

Hint: Change the label font for the adjacent grid tile IDs by adjusting the layer properties for the grid layer this data frame.
Overview Map - Shows the full extent of your map with the location of your primary data frame shown with a red box.
Hint: Change the color of the red location frame in the data frame properties or change its symbol to be solid.

Hint: Add other layers to this data frame such as streets and town boundaries for easier referencing.

Hint: Change the extent of the data frame by zooming in or out. If the zoom tools are inactive, set the extent to "Automatic" in the data
frame properties.

Important! This data frame should not be selected in the "Data frames to zoom" list on the
Main tab.

Text Elements...

The following elements use a keyword to let MainStreetMapbooks know that they should be refreshed with a certain value.
They are standard text elements and you may change their location and font, but changing the keyword in any way will
cause a malfunction.

Date — Adds a date stamp to your page layout that is refreshed with each zoom. Keyword: MBDATE

Time — Adds a time stamp to your page layout that is refreshed with each zoom. Keyword: MBTIME

Type — Adds a stamp to your page layout to display the exported image format and is refreshed with each zoom (exporting
only). Keyword: MBTYPE

DPI — Adds a stamp to your page layout to display the exported image resolution and is refreshed with each zoom
(exporting only). Keyword: MBDPI
Selection tab:

When Printing or Exporting with the "Export maps in list" option, the selected values in the selection list will be zoomed to
and printed/exported.

The Selection field menu is populated with fields from the active layer. Choose a Selection field to load the selection list
with values from the field.

Hint: Use the selection feature to define mapbooks that are a subset of a complete grid system by adding a field to the active (grid) layer
that contains mapbook names or IDs.
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Scale tab:
When the map is zoomed, either from the Navigation area or from the automated printing/exporting, the extent of the

primary data frame is controlled here.

Mapbooks tab:

The Mapbooks tab allows you to save the current MainStreetMapbooks configuration and recall it at a later time.

V - Quirks:
Identical Layer Names — If layers exist in your project that have identical names, the tool may not function properly.

Layer Groups — If you experience problems, try removing any Layer Groups in your project, or moving layers from within a
Layer Group to the top level in your Table Of Contents.

Temporary Files — Temporary image files are created in your user directory within Windows during exporting. If your
image file sizes are large or if you're exporting a large number of images in one run, you may run out of hard disk space on
your local drive or in you temp directory. If you receive errors, you may need to monitor the number of files being created
and delete them periodically.

Read & Write Access To C:\Program Files\MainStreetGIS\ — This plug-in creates a directory structure within

C:\Program Files\MainStreetGIS\ and the user must have read and write access to this directory. On some network
systems, the user may not have appropriate permissions to modify the Program Files directory.
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